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Requirements
Before beginning installation, review the requirements to make sure you have all the hardware 
and software necessary for successful use of Air Gap.
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Air Gap Software Requirements

Setting up Ivanti Endpoint Security in an air gap network requires additional software created
specifically for air gap.

The Air Gap Toolkit

This toolkit includes several tools, utilities, and scripts needed to configure and maintain an Endpoint
Security Server that’s disconnected from the Internet.

The Air Gap Toolkit includes:

l Air Gap Hotfix
l Air Gap License Tool

l AirGapLicenseTool.exe
l AirGapLicenseToolUI.exe

l ImportEndpointManifest.exe
l A couple of scripts that configure your Endpoint Security Server running in the air gap network:

l AirGapScript.sql
l Dependencies.sql

l Ivanti Content Wizard: this tool includes two installable components:
l A server installer (ICWServer.msi)
l A client installer (ICWClient.msi)
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Air Gap Checklist

Before you begin, make sure you have the following materials on hand:

Hardware

l 1 TB of open disk space on both the Air Gap Provider and Air Gap Client.

l 1 TB USB thumb drive. This portable media is used to move software across the air gap.

As a security best-practice, format the thumb drive to remove any software already on
the drive.

Ivanti Software

Download the following software from the Ivanti Download Page.

l The Air Gap Toolkit

After you download the software listed above, move it to your USB thumb drive. You’ll
be using the software on both the Air Gap Provider and the Air Gap Client.

Licensing

l One or more Linux patch content licenses for Endpoint Security.
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Linux Patch Configuration for Air Gap
Before you can patch Linux endpoints operating in an air gap network, you must make special
configurations to:

l The Air Gap Provider
l The Air Gap Client

These configurations only need to be completed once. After you make these configurations, you likely
won't have to complete this process again.
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Air Gap Provider Linux Patch Configuration Overview

If you're going to patch Linux endpoints in your air gap network, extra configuration is required on
your Air Gap Provider.

Each procedure listed below is performed from your Air Gap Provider. Review this list to form a basic
understanding of each procedure you’ll perform  (there will be a similar topic later that provides an
overview for the Air Gap Client).

Before you start, review the "Air Gap Checklist" on page 6. Make sure you have all the
materials you'll need.

1. "Installing the ICW Server on the Provider" on the next page

Install the Ivanti Content Wizard (ICW) Server on your Air Gap Provider. The ICW Server allows
you to export patch content from your Endpoint Security Server. You'll use a USB thumb drive
to move this patch content to your Air Gap Client later.

2. "Installing the ICW Client on the Provider" on page 11

Install the Ivanti Content Wizard (ICW) Client on your Air Gap Provider. The ICW Client is the
console that you use to interact with the ICW Server.

3. "Registering with Linux Vendors" on page 12

Before your Air Gap Provider can download Linux patch content, you have to authenticate with
3rd-party Linux vendors. Configure your Provider to authenticate with Credentials Manager, a
utility that connects with different Linux vendors and authenticates  for you when Endpoint
Security replicates.

4. "Configuring Linux Caching on the Provider" on page 13

Configure Endpoint Security to download Linux patch binaries for each patch released since
your last Air Gap Update.
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Installing the ICW Server on the Provider

Install the Ivanti Content Wizard (ICW) Server on your Air Gap Provider. The ICW Server allows you to
export patch content from your Endpoint Security Server. You'll use a USB thumb drive to move this
patch content to your Air Gap Client later.

To Install the ICW Server on your Air Gap Provider

1. Make sure that the USB thumb drive containing the Air Gap Toolkit is connected.
2. Open Windows Explorer and browse to the USB thumbdrive.
3. Within the thumb drive, browse to Ivanti AirGap Toolkit 8.5.0.40\Software.
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4. Open ICWServer.msi and complete the Ivanti Content Wizard Server Setup.

If you receive the following error, refer to "Troubleshooting" on page 41:

ICW Server is installed.

Proceed to "Installing the ICW Client on the Provider" on the next page.
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Installing the ICW Client on the Provider

Install the Ivanti Content Wizard (ICW) Client on your Air Gap Provider. The ICW Client is the console
that you use to interact with the ICW Server.

To Install the ICW Client on your Air Gap Provider

1. Open Windows Explorer and browse to the USB thumbdrive.
2. Within the thumb drive, browse to Ivanti AirGap Toolkit 8.5.0.40\Software.

3. Open ICWClient.msi and complete the Ivanti Content Wizard Client Setup.

ICW Client is installed.

Proceed to "Registering with Linux Vendors" on the next page.
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Registering with Linux Vendors

Before your Air Gap Provider can download Linux patch content, you have to authenticate with 3rd-
party Linux vendors. Configure your Provider to authenticate with Credentials Manager, a utility that
connects with different Linux vendors and authenticates  for you when Endpoint Security replicates.

1. Open a command prompt.

2. Change directories to C:\Program Files (x86)\HEAT Software\EMSS\Replication Services.

3. Enter the following usage based on the versions of Linux you are supporting.

credentialsmanager.exe /source:vendor /release:OSversion
/arch:processorarchitecture /u:username /p:password
/hostname:airgapprovidername

l If you are supporting CentOS endpoints, you do not need to register.
l For additional help with usage, refer to "Credentials Manager Usage Reference" on

page 42.
l Repeat this command for each operating system you're supporting.

4. Enter yes to use SSL communication.
5. Close the command prompt.

Continue to "Configuring Linux Caching on the Provider" on the next page.

Page 12 of 47

Ivanti Endpoint Security: Air Gap Linux Patching Guide



Configuring Linux Caching on the Provider

Configure Endpoint Security to download Linux patch binaries for each patch released since your last
Air Gap Update.

1. Create the following folder at the root of your drive:

C:\Basic Linux NCA Air Gap Solution.
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2. From Windows Explorer, browse to the following location on your USB thumb drive that
includes the Air Gap Toolkit:
HEAT AirGap Toolkit 8.5.0.40\Tools\Endpoint Security
\00000000-0000-0000-0000-000000000000\LinuxNCA.
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3. Open PopulateCache.exe.config in a text editor.

4. Change the following <add/> tag from this:

<add key="xmlActiveProcessingPath" value="c:\AirGap\Archive"/>

to this:

<add key="xmlActiveProcessingPath" value="C:\Basic Linux NCA Air Gap Solution"/>

5. Save the text file and close it, but leave the Windows Explorer instance open (you'll be copying
files from this instance to another one).
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6. Open a second instance of Windows Explorer. Browse to C:\Program Files (x86)\HEAT
Software\EMSS\Replication Services.

7. Copy the following files from the USB thumb drive and paste them in the Replication Services
folder (Air Gap Provider).

l PopulateCache.exe
l PopulateCache.exe.config

8. Copy the CacheManagerInstaller folder from the Replication Services folder (Air Gap Provider)
and paste it in the LinuxNCA folder (USB thumb drive).

You must move this folder to the Air Gap Client later, so move it to your USB thumb drive now
while it's convenient.

9. Close the Replication Services folder.

Proceed to "Air Gap Client Linux Patch Configuration Overview" on the next page.
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Air Gap Client Linux Patch Configuration Overview

To patch Linux endpoints in your air gap network, you must make configurations to your Air Gap
Client so that it can receive Linux patches.

Each procedure listed below is performed from your Air Gap Client. Review this list to form a basic
understanding of each procedure that you'll perform.

Before you start, review the "Air Gap Checklist" on page 6. Make sure you have all the
materials you'll need.

1. "Installing the ICW Server on the Client" on the next page

The Ivanti Content Wizard (ICW) Server is also used on your Air Gap Client to import patch
content. Install the ICW Server on your Air Gap Client so it can receive patch content updates.

2. "Installing the ICW Client on the Client" on page 20

Install the Ivanti Content Wizard (ICW) Client on your Air Gap Client so that you can interact
with the ICW Server using a console.

3. "Configuring the Linux Caching on the Client" on page 21

Configure your Air Gap Client so that it can receive Linux patch content from your Air Gap
Provider.
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Installing the ICW Server on the Client

The Ivanti Content Wizard (ICW) Server is also used on your Air Gap Client to import patch content.
Install the ICW Server on your Air Gap Client so it can receive patch content updates.

To Install the ICW Server on your Air Gap Client

1. Make sure that the USB thumb drive containing the Air Gap Toolkit is
connected.

2. Open Windows Explorer and browse to the USB thumbdrive.
3. Within the thumb drive, browse to Ivanti AirGap Toolkit 8.5.0.40\Software.

Page 18 of 47

Ivanti Endpoint Security: Air Gap Linux Patching Guide



4. Open ICWServer.msi and complete the Ivanti Content Wizard Server Setup.

If you receive the following error, refer to "Troubleshooting" on page 41:

ICW Server is installed.

Proceed to Installing the ICW Client on the Client.
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Installing the ICW Client on the Client

Install the Ivanti Content Wizard (ICW) Client on your Air Gap Client so that you can interact with the
ICW Server using a console.

To Install the ICW Client on your Air Gap Client

1. Open Windows Explorer and browse to the USB thumbdrive.
2. Within the thumb drive, browse to Ivanti AirGap Toolkit 8.5.0.40\Software.

3. Open ICWClient.msi and complete the Ivanti Content Wizard Client Setup.

ICW Client is installed.

Proceed to "Configuring the Linux Caching on the Client" on the next page.
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Configuring the Linux Caching on the Client

Configure your Air Gap Client so that it can receive Linux patch content from your Air Gap Provider.

1. Open your Start Page or Start Menu. Search for Services, and then open it.

2. Stop the Replication Service. Then minimize the Services dialog (you'll need it later).
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3. From Windows Explorer, browse to the following path on the your USB thumb drive:
HEAT AirGap Toolkit 8.5.0.40\Tools\Endpoint Security
\00000000-0000-0000-0000-000000000000\LinuxNCA.
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4. Open a second instance of Windows Explorer. Browse to C:\Program Files (x86)\HEAT
Software\EMSS\Replication Services.

5. Copy the entire contents of the LinuxNCA folder (USB thumb drive) and paste them in the
Replication Services folder (Air Gap Client).

When prompted, replace the files in the Replication Services folder.
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6. Switch back to the Services dialog and restart the Replication Service. Close the dialog.

7. From the Replication Services folder on the Air Gap Client (not the USB thumb drive), run
RunCacheManagerInstaller.exe.

A command prompt window opens and RunCacheManagerInstaller.exe runs quickly, then
closes.

Does the command line window fail to open? See "Troubleshooting" on page 41.

8. Close the Replication Services folder.

The Air Gap Client is configured to receive Air Gap Updates for Linux.

Both the Provider and Client are configured. You can now begin creating Air Gap Updates for Linux.

Proceed to "Linux Air Gap Updates" on page 25
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Linux Air Gap Updates
This chapter guides you through the standard air gap Linux patching workflow.

An Air Gap Update is a bundle of new Endpoint Security content that is moved from the Air Gap
Provider to the Air Gap Client. Updates include the software that is used to secure your endpoints in
an air gap network. Updates can include any of the following content:

l Windows Patch Content
l Linux Patch Content
l AntiVirus Definitions

Making an Air Gap Update for Linux consists of two parts:

l Creating an Air Gap Update, which takes place on the Air Gap Provider
l Installing an Air Gap Update, which takes place on the Air Gap Client

We recommended making an Air Gap Update every Patch Tuesday, or when a critical security
vulnerability is found that needs to be patched immediately.
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Linux Air Gap Update Creation Overview

This overview summarizes each process required to create an Air Gap Update that includes Linux
patch content.

All procedures in this overview are performed from the Air Gap Provider. There will be another
overview similar to this one for the process of installing the Update on your Air Gap Client.

Before you start, review the "Air Gap Checklist" on page 6. Make sure you have all the
materials you'll need.

1. "Replicating With the Global Subscription Service" on page 28

Begin by initiating a replication with the Global Subscription Service (GSS), which is a cloud
service for your Endpoint Security Server. You can download the latest:

l License information
l System updates
l Patch content
l AntiVirus definitions

Although this process isn't absolutely required because the Air Gap Provider automatically
replicates once daily by default, we recommend replicating before creating an Air Gap Update.

2. "Caching Linux Patches" on page 31

After replicating to download the latest Linux patch metadata, you need to download the Linux
patch binaries themselves—a process known as caching.

The initial cache download takes a long time (download times vary with your connection
speed).

l We're potentially talking days here. Plan appropriately to allow the download to
complete.

l Before you begin the download, make sure you have enough disk space to complete the
download. We recommend limiting the amount of content that you download by
disabling the Linux repository channels that you don't use. This can be a big time saver.
For more information, see "Configuring Linux Content Channels" on page 41.

l Don't worry if the caching process is taking long; this is expected. Allow the process to
complete uninterrupted.

3. "Exporting Linux Patches" on page 33

Use the Ivanti Content Wizard to export your Linux patches from the Air Gap Provider to your
USB thumb drive.
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4. "Copying Linux Patch Metadata" on page 36

Bring your Linux patch metadata over the air gap so that you can view the Linux patches on
your Air Gap Client and deploy them. Begin this process by copying the Linux patch metadata
on your Provider to a USB thumbdrive.
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Replicating With the Global Subscription Service

Begin by initiating a replication with the Global Subscription Service (GSS), which is a cloud service for
your Endpoint Security Server. You can download the latest:

l License information
l System updates
l Patch content
l AntiVirus definitions

Although this process isn't absolutely required because the Air Gap Provider automatically replicates
once daily by default, we recommend replicating before creating an Air Gap Update.

To Replicate With the GSS

1. From the Air Gap Provider, log into the Endpoint Security Console.
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2. From the Navigation Menu, select Tools > Subscription Updates.

3. Click Update Now.

4. Make sure System and License Replication is selected and then click OK.
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5. Watch the window and wait for patch replication to complete.

Continue to "Caching Linux Patches" on the next page.
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Caching Linux Patches

After replicating to download the latest Linux patch metadata, you need to download the Linux patch
binaries themselves—a process known as caching.

The initial cache download takes a long time (download times vary with your connection speed).

l We're potentially talking days here. Plan appropriately to allow the download to complete.
l Before you begin the download, make sure you have enough disk space to complete the

download. We recommend limiting the amount of content that you download by disabling the
Linux repository channels that you don't use. This can be a big time saver. For more
information, see "Configuring Linux Content Channels" on page 41.

l Don't worry if the caching process is taking long; this is expected. Allow the process to
complete uninterrupted.

To Cache Linux Patches
1. From your Air Gap Provider, open a command console.
2. Change directories to the Replication Services folder:

C:\Program Files (x86)\HEAT Software\EMSS\Replication Services\

If you have your USB thumb drive connected, you can also change to the following directory on

your thumb drive (either one will work):

Ivanti AirGap Toolkit 8.5.0.40\Tools\000000000-0000-0000-000000000000\LinuxNCA\
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3. Enter the following command: PopulateCache.exe /verbose=true

4. Continue through the prompts and wait for the download to complete. When the download
finished, close the command prompt.

Don't disturb your initial cache download. Don't do it.

Continue to "Exporting Linux Patches" on the next page.
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Exporting Linux Patches

Use the Ivanti Content Wizard to export your Linux patches from the Air Gap Provider to your USB
thumb drive.

To Export Linux Patches

1. Make sure you have a USB thumb drive connected to your Air Gap Provider.

2. Open ICW Client and connect to the ICW Server.
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3. Select File > Export Wizard.
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4. Use the Export Wizard to export your Linux patches to your USB thumb drive.

l For the first Air Gap Update you create, don't select any filter option. Just Click Go.

l If you're making a follow up Air Gap Update, use the modification date filter to find only
patches that have been cached since your previous Air Gap Update.

5. Close the Ivanti Content Wizard Client.

Your Linux patch content is transferred to the USB thumb drive.

Continue to "Copying Linux Patch Metadata" on the next page.
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Copying Linux Patch Metadata

Bring your Linux patch metadata over the air gap so that you can view the Linux patches on your Air
Gap Client and deploy them. Begin this process by copying the Linux patch metadata on your Provider
to a USB thumbdrive.

To Copy Linux Patch Metadata

1.1. Make sure you have a USB thumb drive connected to your Air Gap Provider.
2. From Windows Explorer, browse to C:\Program Files (x86)\HEAT

Software\EMSS\Content\00000000-0000-0000-00000000000\.
3. Open a second instance of Windows Explorer. Browse to your USB thumb drive.

4. Copy the following folders from your Air Gap Provider to your USB thumb drive:

l Linux
l repository

Your Linux patch metadata is moved to your USB thumb drive.

Continue to "Linux Update Installation Overview" on the next page.
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Linux Update Installation Overview

This overview summarizes each process required to install a Linux Air Gap Update on your Client.

All procedures in this overview are performed from the Air Gap Client.

Before you start, review the "Air Gap Checklist" on page 6. Make sure you have all the
materials you'll need.

1. "Importing Linux Patch Content" on the next page

On your Air Gap Client, import the Linux patches that are on your USB thumb drive.

2. "Installing Linux Patch Metadata" on page 40

Install the Linux patch metadata that you copied to your USB thumb drive earlier so that you
can view your patches on the Air Gap Client.

Page 37 of 47

Ivanti Endpoint Security: Air Gap Linux Patching Guide



Importing Linux Patch Content

On your Air Gap Client, import the Linux patches that are on your USB thumb drive.

To Import Linux Patch Content

1. Log in to your Air Gap Client.
2. Make sure that the USB thumb drive containing your Linux patches is connected to the Air Gap

Client.

3. Open ICW Client and connect to the ICW Server.
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4. Select File > Import Wizard.

5. Use the Import Wizard to import the Linux patches on your USB thumb drive.

6. When you're done, close the ICW Client.

Your Linux patch content is imported to your Air Gap Client.

Continue to "Installing Linux Patch Metadata" on the next page.
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Installing Linux Patch Metadata

Install the Linux patch metadata that you copied to your USB thumb drive earlier so that you can view
your patches on the Air Gap Client.

1. From Windows Explorer, browse to C:\Program Files (x86)\HEAT
Software\EMSS\Content\00000000-0000-0000-00000000000\.

2. Open a second instance of Windows Explorer. Browse to your USB thumb drive.

3. Copy the following folders from your USB thumb drive to the Air Gap Client.

l Linux
l repository

4. Close each instance of Windows Explorer.

Your Linux patch metadata is installed on your Air Gap Client.
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Appendix
This appendix contains reference information for edge-case scenarios and troubleshooting related to
your air gap Endpoint Security installation.

Troubleshooting

There are a few parts during air gap configuration that are prone to trouble. Hopefully this help topic
can get you through them :)

When I try to execute RunCacheManagerInstall.exe, nothing happens

Cause: RunCacheManagerInstall.exe may not be is the correct folder. Make sure that the file is in the
following path before running it:

C:\Program Files (x86)\HEAT Software\EMSS\Replication Services

Solution: Move RunCacheManagerInstall.exe into the correct folder. Then retry opening it.

Configuring Linux Content Channels

For Air Gap  customers that patch Linux endpoints, Ivanti recommends configuring the Linux content
channels before running PopulateCache.exe. This practice offers the following benefits:

l Reduced total size of Air Gap Updates including Linux patches.
l Improved caching times while running PopulateCache.exe.
l Reduced number of nonessential patches on the Air Gap Client.

Configure your Linux Content Channels by editing the RepositoryList.xml file on the Air Gap Provider.
This file can be opened from the following path:

C:\Program Files (x86)\HEAT Software\EMSS\Content\00000000-0000-0000-
000000000000\Linux\RepositoryList.xml

To Configure Linux Content Channels

Open the RepositoryList.xml file. You can subscribe (or unsubscribe) to different content channels by
changing the authorized attribute for a given Linux release.

l To subscribe to a channel, edit the attribute to authorized="true"
l To unsubscribe from a channel, edit the attribute to authorized="false"

You must manually edit this file each time prior to running PopulateCache.exe. Each
replication with the Global Subscription Service resets the file to its default values.

Example XML

<?xml version="1.0" encoding="utf-8"?>
 <repositories xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
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  xmlns:xsd="http://www.w3.org/2001/XMLSchema">

 CHANNEL AUTHORIZED SET TO "false"

 <repository vendor="RedHat" arch="i386" version="3" release="AS">
  <channel authorized="false">rhel-i386-as-3<channel>
 </repository>
 <repository vendor="RedHat" arch="x86_64" version="3" release="AS">
  <channel authorized="false">rhel-x86_64-as-3<channel>
 </repository>
 <repository vendor="RedHat" arch="i386" version="3" release="ES">
  <channel authorized="false">rhel-i386-es-3<channel>
 </repository>

< <channel authorized="false">rhel-x86_64-es-3<channel>
 </repository>
 <repository vendor="RedHat" arch="i386" version="3" release="WS">
  <channel authorized="false">rhel-i386-ws-3<channel>
 </repository>
 <repository vendor="RedHat" arch="x86_64" version="3" release="WS">
  <channel authorized="false">rhel-x86_64-ws-3<channel>
 </repository>
 <repository vendor="RedHat" arch="i386" version="4" release="AS">
  <channel authorized="false">rhel-i386-as-4<channel>
 </repository>

 CHANNEL AUTHORIZED SET TO "true"

 <repository vendor="CentOS" arch="i386" version="4" release="Server">
  <channel authorized="true">centos-4-i386<channel>
 </repository>
 <repository vendor="CentOS" arch="x86_64" version="4" release="Server">
  <channel authorized="true">centos-4-x86_64<channel>
 </repository>
 <repository vendor="CentOS" arch="i386" version="5" release="Server">
  <channel authorized="true">centos-5-i386<channel>
 </repository>
 <repository vendor="CentOS" arch="x86_64" version="5" release="Server">
  <channel authorized="true">centos-5-x86_64<channel>
 </repository>

 </repositories>

Credentials Manager Usage Reference

Credentials Manager Commands and Parameters

Use the following parameters in conjunction with the CredentialsManager.exe command.
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Parameter Description

source The Linux vendor that you are supporting.

l redhat | oracle | solaris | hpux | suse

u Your user name for the Linux vendor portal.

p Your password.

hostname The hostname of your Air Gap Provider.

release The version of Linux that you are supporting.

l redhat: 5Server | 5Client | 6Server | 6Workstation
l oracle: 4 | 5 | 6

arch The processor architecture of the operating system that you are supporting.

l i386 | x86_64

path The path where the Air Gap Provider will store the system ID assigned by the Red Hat
Network.

export Exports the Red Hat Network Certificate Authority certificate to the current
directory.

a (SUSE only)

The account type. Use the SUSE9 value for SUSE 9 support, and use MIRROR value
for SUSE 10 and 11 support.

l SUSE9 | MIRROR

? Shows usage for the CredentialsManager.exe command and its parameters.

Credentials Manager Usage Examples

l Usage in bold denotes required commands and parameters.
l Usage in italics denotes a variable that applies to your environment.

Redhat

CredentialsManager.exe /source:redhat
/u:redhatNetworkLogin /p:redhatNetworkPassword
/hostname:airGapClientHostname
/release:5Server|5Client|6Server|6Workstation /arch:i386|x86_64

/path:systemIDPath /export

Oracle

CredentialsManager.exe /source:oracle
/u:oracleLinuxNetworkLogin /p:oracleLinuxNetworkPassword
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/hostname:airGapClientHostname /csi:oracleCSI
/release:4|5|6 /arch:i386|x86_64 /path:systemIDPath

Solaris

CredentialsManager.exe /source:solaris
/u:oracleUsername /p:oraclePassword

HP-UX

CredentialsManager.exe /source:hpux
/u:HPITResourceCenterUser /p:HPITResourceCenterPassword

SuSE

CredentialsManager.exe /source:suse
/u:novellLogin /p:novellPassword
/a:MIRROR|SUSE9
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Glossary

A

Air Gap
A highly secure computing environment where a network of computers is
isolated from other networks, and most often, from the Internet. This practice
significantly reduces the attack surface of endpoints within the air gap, and is
used most often in industries that handle sensitive information, such as the
defense industry.

Air Gap Client
An Endpoint Security Server in an air gap environment that secures the
endpoint in your air gapped network. The Air Gap Client is not connected to the
Internet. Since the Client has no Internet connection, it relies on the Air Gap
Provider to move system updates and content over the air gap.

Air Gap Hotfix
A utility that moves Endpoint Security binaries and modules on to an Air Gap
client. This utility copies all the files necessary to complete an air gap install or
upgrade, and then the user opens Installation Manager to complete the module
installation.

Air Gap License Tool
A utility used to import a license for an Endpoint Security Server operating in an
air gap network.

Air Gap Provider
An Endpoint Security Server that's connected to the Internet in an air gap
environment. This server downloads Endpoint Security system components and
content from the Internet. These components and content is then moved across
the air gap to the Air Gap Client, which then uses this content to secure your air
gap endpoints.
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Air Gap Toolkit
A bundle of software that includes tools, utilities, and scripts needed to
configure and maintain an Endpoint Security Server that’s disconnected from
the Internet.

AirGapScript.sql
A script that disables the replication process on an air gap Endpoint Security
Server (also known as an Air Gap Provider). The script prevents the Air Gap
Provider from trying to communicate and download content from the cloud.

C

caching
The process of downloading patch content binaries from the Global
Subscription Service. You can cache either Windows or Linux content.

Credentials Manager
A utility that connects to different Linux vendors and passes on the credentials
that you've purchased from the vendor. When you replicate with the Global
Subscription Service or cache Linux content, Endpoint Security passes your
credentials to the vendors so that Endpoint Security download Linux patch
metadata and binaries.

D

Dependencies.sql
A script that installs Endpoint Security prerequisites on a server that doesn't
have Internet access.

G

Global Subscription Service
A cloud server that hosts Endpoint Security system data, patch content, and
antivirus content.
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I

ImportEndpointManifest.exe
A utility used to enable new versions of the Endpoint Security Agent included in
an air gap update. Use this tool after installing or upgrading an air gap Endpoint
Security Server (also known as an Air Gap Client).

Ivanti Content Wizard
A utility used to create your own patches for Endpoint Security. This tool lets
you add patches and additional files that check for prerequisites.  In air gap
networks, Ivanti Content Wizard is used to bundles patches and then move
them into your air gap network.

R

Replication
The synchronization process between the Endpoint Security Server and the
Global Subscription Server. During this process, Endpoint Security downloads
the latest Endpoint Security system updates, patch content, and antivirus
content. Depending on how much content you are licensed for, initial replication
can take as long as an hour. Subsequent replications are much faster.
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